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Adobe Illustrator Class 

A little back story 
Around 1970, Xerox Corp, headquartered in New York, established a research center in the Stanford 
Industrial park and called it PARC (Palo Alto Research Center). 

In the mid 70’s, the scientists/engineers at PARC invented Laser Printing. This allowed high resolution 
graphics to be printed easily (500 dots per inch in the prototype). They defined a page description 
language call “Press” that could be sent to the printer controller. A downside, if you wanted to print 
with a font of a given size, there had to be a set of bitmaps (at 500 dpi) for each of the characters of 
that font. 

In 1978, John Warnock joined PARC. Based partially on work that he had done in Utah, where he 
received his PhD, he created a committee to design a language for describing page contents that was 
resolution independent and could be used to print on a multiplicity of devices. It was called 
InterPress. John and his team wanted to publish the language so that everybody would describe 
pages in the same way. Unfortunately, the corporate legal staff didn’t approve of the idea.  

In frustration, Warnock and another researcher, Chuck Geschke, decided to leave Xerox in 1982 and 
found their own company. They named it Adobe Systems after the creek that ran behind John’s 
house. For legal reasons, they had to create a new page description language, which wasn’t a bad 
ideal since InterPress had a number of “designed by a committee” inefficiencies. They designed 
PostScript, again largely influenced by Warnock’s work in Utah. 

PostScript is essentially a programming language that has built-in functions for marking information 
on pages. You can define lines, straight or curved, you can do strokes and fills. Bitmap images can be 
scaled (but if scaled too large, the “bits” of the original can be seen).  Fonts describe their characters 
as filled outlines, so they can be scaled to any desired size.  

In the early to mid  80’s some Japanese manufacturers produced small laser printers. In ‘84, Hewlett 
Packard began selling the LaserJet based on a Canon printer engine (300 dpi). In ’85, Apple released 
the LaserWriter based on the same Canon printer. 

In 1983, Adobe was hired by Apple to produce the LaserWriter, the first PostScript printer.  Around 
that time, Adobe also had an agreement with Linotype to create a PostScript engine to produce very 
high resolution page images. 

Having PostScript was a great improvement to the printing industry. In the early days, writing a 
PostScript print driver for simple things like a text editor wasn’t too hard. Creating complicated 
graphics was a serious pain. With Apple selling a PostScript printer, there was a perceived need for a 
graphics editor for the Mac to produce PostScript. 
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Largely the work of programmer Mike Schuster, Adobe Illustrator came out on the Mac in 1987. 
Several years later, a version came out for Windows, though it had to go through several generations 
before it was as well received as the Mac version. 

Class Goals 
Adobe Illustrator has been around for more than 30 years. It has gone through many releases and 
acquired many features in that time. The goal of this course is to teach you the basics. In particular, 
the features you will find useful when producing projects to be sent to the CraterWorks Laser Cutter. 
When you get down to the basics, an Illustrator file consists of many lines, some closed figures 
defined by outlines, text, and some embedded raster images. We will not talk about all of the ways to 
create content, but will hopefully cover enough to be useful. After the overview, we will make a small 
project from start to finish. 

For this class, I am using a PC. The description below uses the designation Ctrl and Alt for the keys 
used in many shortcuts.  On a Mac, those would correspond to Command (⌘) and Option (⌥). The 
Mac also has a Control key, but it is not used for the keyboard shortcuts.  

One thing that is definitely true about Illustrator is that there are multiple ways of doing just about any 
task. If you have an afternoon or two to spare, you should consider going to 
http://helpx.adobe.com/illustrator/tutorials.html and looking at some of the tutorials. In particular, the 
page entitled “Get to know Illustrator” is linked to nine other pages with a total of 41 videos to watch. Each 
video comes with a downloadable zip file of documents you can use to follow along in your own copy of 
Illustrator. Some of the more advanced topics do not have videos, but step-by-step instructions and 
illustrations. 

First Approach to Illustrator 
When you first start Illustrator, you are prompted to either open an existing document or to create a 
new one. A document consists of one or more “artboards”. There are a number of pre-defined 
choices of size, orientation, and other parameters, or you can specify your own. These choices can be 
modified once the artboard is created. 

The preference that I typically change is “Units”. While Points (1/72 inch) are fine with me for Stroke 
widths and font sizes, I find them pretty annoying for dimensioning something that I’m going to cut 
on the laser cutter. I’m in the habit is using metric measurements for projects so I use millimeters for 
my units.  

You have 10 choices of units, including inches, feet, etc. You can also change the default units later 
using the Properties window for document properties. If you want to use other than points for font 
sizes and stroke widths, the “Units” menu item under the “Preferences” menu (under “Edit” at the 
top of the window) can be used to modify those units as well. In the remainder of this document, I 
will denote such multiple selections through the top window menus as “Edit”->”Preferences”-
>”Units”.  For this particular set of menus, you can type Ctrl+k then choose your final menu from a list 
of the left of the page. 

http://helpx.adobe.com/illustrator/tutorials.html
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Independent of what the default document units are defined to be, you can enter values into various 
widgets in whatever unit you please. So if you specify a size as 1in (or 1”) in a dialog box but your 
default unit is millimeters, when you Tab to the next field, the value will be displayed as 25.4 mm. 
The space between the number and the units is optional, i.e. 1 in or 1in will both work. 

One of the more useful features is the 
ability to have multiple “layers” on your 
artboard. Layers can have controlled 
visibility and can be “locked” so that the 
artwork on that layer is protected. The 

three bars at the top right lead to a menu for doing things like creating new layers.  Once you have 
multiple layers, anything on a given layer is rendered on top of anything in layers below. The order of 
the layers can be modified by dragging a layer in the Layers window to a new position in the depth 
hierarchy. 

Navigation 
You may zoom in and out on the artboard. This allows you to better see the portion that you are 
modifying. There are several ways to do this. At the bottom left corner of the window, there is a 
widget to specify a zoom percent. You can choose a zoom value from the pop-up menu, or you can 
type in an exact number. In the “View” menu at the top of the window, there are “Zoom in” and 
“Zoom out” menu items.  They change the magnification to the next value in that widget’s list of 
values.  In the Tool Window, you can choose the “Zoom Tool” (a magnifying glass).  When you choose 
the tool, the cursor becomes a magnifying glass with a “+” in the middle. If you click on the artboard, 
it will be zoomed to the next larger magnification, centered on where you clicked. Holding down Alt 
with the Zoom Tool changes the “+” in the magnifying glass changes to a “-“. Clicking the tool will 
zoom out, centered on where you click. 

There are some useful keyboard shortcuts. If you type Ctrl+1, you will zoom to 100%, i.e., actual size. 
If you type Ctrl+0, you will zoom to whatever magnification is required to show the entire artboard in 
the window. Ctrl with the “+” key will zoom in and Ctrl with the “-“ key will zoom out. 

If you are zoomed in on a portion of the drawing, you may wish to scroll the content to get to a 
portion that is not currently on screen. There are scroll bars at the bottom and right side of the sub-
window containing the artboard that can be used for this purpose. In the Tool Window, you can 
choose the “Hand Tool”. The Hand Tool allows you to mouse down at any place on the artboard and 
drag that part of the board to another part of the window, allowing “scrolling” horizontally and 
vertically at once.  

Unless you are actively entering text, pressing the Space-bar temporarily selects the Hand Tool. 
When you release the Space-bar, the selected tool goes back to whatever it was before. Again, while 
not entering text, pressing the Space-bar and Ctrl together temporarily selects the “Zoom Tool”  
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If you mouse down and drag the Zoom Tool, the behavior depends on the setting of a global 
parameter.  Historically, one dragged the mouse across the screen and the rectangle defined by 
mouse down and mouse up was zoomed as large as possible in the window. Newer versions have a 
second option.  In the menu item “Edit”->”Preferences”->”Performance”, there is a checkbox entitled 
“Animated Zoom”. If this box is checked, dragging the zoom tool causes the drawing to grow or shrink 
as you drag. If you drag to the right, you zoom in; if you drag to the left, you zoom out. Because I’ve 
been using the original behavior for over 30 years, I uncheck the Animated Zoom checkbox (old dog, 
old tricks). 

Drawing in Illustrator 
Typically on the left side of the window is the “Tool Window”. It contains icons for 
many tools, some of which we will talk about below. To conserve screen real estate, 
similar tools are grouped together with the most recently used one showing. If there 
is a small triangle in the lower right corner of the tool icon, it indicates that there are 
similar tools “below”. If you mouse down on the triangle and hover there, the 
complete set of tools will be shown in a pop-up menu. Choose the one you wish to 
use. A gray background designates the currently selected tool. In the example here, 
the Selection Tool is chosen. If a tool that you want to use isn’t currently in the Tool 
Window, you can click on the three dots at the bottom of the Tool Window and drag 
that tool back in. Alas, I have no wisdom to impart about how to find a tool that is 

stacked below some other tool. Look for the tool that is closest to what you want and mouse down 
on the triangle to see if your desired tool is hiding under there. 

Objects created in Illustrator have the option of stroke and fill colors. Typically in the 
toolbar on the left there is a pair of boxes that are used to specify those colors. We 
will get into the details of color later, but for now, the specification depicted here is 
for objects that have a black stroke on their outline and no fill. 

 

Grid and Guides 
Illustrator provides several useful mechanisms for drawing objects of exact dimensions.  One such 
mechanism is the “Grid”. If the grid is turned on, it is displayed in the background of the artboard. If 
“Snap to Grid” is selected, all objects will have their control points at some intersection of grid lines. 
The default grid is major lines every inch and minor ones every eighth of an inch. That can be changed 
using “Edit”->”Preferences”->”Guides & Grid” from the menus at the top of the window. One way to 
turn the grid on and off (and to specify Snap to Grid) is via the “View” menu at the top of the window. 

While the grid can be useful for some drawings, I prefer the use of “Guides”.  They are created by 
drawing a line and then turning it into a Guide.  This is done either by the top menu “View”-
>”Guides”->”Make Guides” or by the keyboard shortcut Ctrl+5. The “View”->”Guides” menu also 
allows you to lock and unlock the guides.  Typically they should be locked, but if you want to move 
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one, they need to be unlocked while you are doing that. I tend to have a special layer for guides and 
lock that layer rather than lock the guides.  We will see the use of guides below. You can think of a 
collection of guides as forming a grid that is specific to the dimensions of the art you wish to draw. 

Simple Shapes 
There are lots of ways to draw objects in Illustrator. The original version had basic capabilities, but 
later versions have added many tools for drawing common shapes. If you select one of these tools, 
you can “mouse down” and drag, creating that shape of a size determined by how far you drag the 
mouse before letting go of the mouse button. 

Another way is to “click” the mouse at a location on the artboard (without moving it). This will bring 
up a dialog box that will allow you to specify the dimensions (and perhaps other parameters) 
explicitly. This is handy if, say, you want a rectangle that is 25mm by 50mm. Also, for the Polygon and 
Star tools, the dialog box has a field for specifying the number of sides or points. It is worth noting 
that when you change the shape of a star or polygon, that new shape persists for future invocations 
of the tool. Let’s look at bit further at each of these simple shape tools. 

 If you simply use this tool, you will draw a rectangle with a corner point 
where you first pressed the mouse button. There are additional options. 

If you hold down the Shift  key while you are “dragging”, the rectangle will be restricted to being a 
square. If you hold down the Alt key, the position of the initial mouse press becomes the center of 
the rectangle, not one of the corners. This is true even if you simply click the mouse with Alt down. In 
that case you can specify the dimensions of the rectangle that is centered on where you clicked the 
mouse. 

This tool allows you to create rectangles with rounded 
corners. You can specify the radius if you “click” this tool and 

you can always go back and modify the radius after drawing the rectangle. Again, Shift and Alt 
behave the same as they do for the Rectangle Tool. 

 This tool draws ellipses. If you hold down Shift, you get a circle. If you hold 
down Alt, the ellipse/circle is centered about the point where you pressed the mouse button. If you 
“click”, you can specify the height and width of the ellipse. 

 

 This tool creates multi-sided (regular) polygons. The polygons are centered on 
the location of mouse down. Holding down Shift keeps the polygon in upright alignment. If you use 
the Up-Arrow and Down-Arrow keys while the mouse is still down, you change the number of sides 
in the polygon. I’m not aware of any effect from the Alt key on this tool since you are always drawing 
with the center at mouse down. If you “click”, you can specify the number of sides and the radius 
(which is the radius of a circle that would exactly enclose the polygon). 



6 
 

 This tool creates stars centered on the position of mouse down. By holding down 
Ctrl, you can adjust the “pointiness” of the star. Holding down Shift constrains the orientation to be 
upright. Holding down Alt, if the start has 5 or more points, constrains the shape of the star to be the 
shape you’re used to seeing in things like the American flag, i.e., the sides of star points two apart are 
in a straight line; with 6 sides, it will be a Star of David. While the mouse is down, the Up-Arrow and 
Down-Arrow keys control the number of points on the star. If you “click” this tool, you get a dialog 
box that lets you specify details of the star to create. 

Drawing Lines 
There are a number of tool for drawing lines.  

Use this tool to draw a single straight line. If you hold down Shift, the 
direction is constrained to horizontal, vertical, or 45° away from one of those directions. If you hold 
down Alt, you get a straight line centered upon the location of mouse down. If you “click”, you can 
specify the length and the angle. 

 This tool draws a quarter of an ellipse. If Shift is down, it’s a quarter-circle. If Alt is 
down, it draws the arc such that the mouse down point is at the center of a straight line joining the 
two ends of the arc. If you “click”, you can specify lots of parameters. 

This tool draws a spiral. While the mouse is down, the Up-Arrow and Down-
Arrow keys control the number of segments in the spiral. The Shift key constrains the orientation, the 
Ctrl key lets you turn the spiral inside out, changing it from clockwise to counter-clockwise. Alt causes 
it to add and subtract segments as the spiral gets larger or smaller. If you “click”, you can specify lots 
of parameters. 

and These tools draw grids. You can play 
with them and see what they do. The Up-Arrow, Left-Arrow, Right-Arrow, and Down-Arrow keys 
control the number elements in the grid. 

This is the granddaddy of line creation tools. It is not particularly easy to explain.  
Lines created with the pen tool have a sequence of anchor points. Line segment 

directions either terminate at the anchor point or this segment and the segment on the other side of 
the anchor have a coordinated shape that is controlled by direction lines that appear when the 
anchor is directly selected.  The tool keeps adding to a line until you reach back to your starting 
anchor (or change to another tool). When you have a closed figure, the Pen Tool is now ready to start 
another object. There are also tools in this stack for adding and subtracting anchor points from a line. 

This tool is a simpler version of the Pen Tool. It was not part of the 
original Illustrator, but has been added to make you life easier for 
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making smooth curves. Try it for yourself. If you double-click at a point, the current curve will 
terminate there. It can also be used to add control points to an existing line. 

This tool allows you to draw a curve free-hand, and have Illustrator convert 
it into a line with control points. If you double-click on this tool in the Tool 

Window, it will open the “Pencil Tool Options” window that has several options for affecting the 
conversion process. 

Images 
Sometimes you wish to place an image on the artboard.  This is done using the “File” menu at the top 
of the window. Choose the “Place” menu item. You will be prompted for a file. Choose an image file 
and click the “Place” button.  You will now see a miniature version of the image and an arrow. 
Position the arrow where you want the upper left corner of the image and click the mouse, or drag it 
to set the initial scaling of the image. Images are by default “linked”, meaning that the Illustrator file 
has a link to the image. If the image is altered, the changes are reflected in the Illustrator file next 
time it is opened. One can “Embed” the image in the Illustrator file, and must do so if you crop the 
image. 

If an image is selected, the Properties Window has a number of “Quick Actions”.  For some images, 
the “Image Trace” button can turn the selected image into scalable objects. After you select “Image 
Trace”, you can open ”Window”->”Image Trace” to allow you to set various parameters for the 
process and preview their effects. When you are happy with the results, you can click “Expand” to 
convert to a group of editable objects. 

Clipping Masks 
There are times when you only want to use a portion of an illustration. This is common for placed 
images but can be used also with collections of other object that you have drawn.  This is  simply 
done by selecting a group of two or more objects. Then choose from the window top menu “Object”-
>”Clipping Mask”->”Make”, or simply type Ctrl+7. The topmost object in the selection is used as a 
clipping mask and anything below that falls outside of the mask is no longer visible. It is helpful to 
select the desired mask object, then type Ctrl+x, Ctrl+f to ensure that it is front of the other objects. 

Text 
There are a number of ways to add text to an Illustrator artboard. We will discuss several of them 
below. You can play with the options and see for yourself. More recent versions of Illustrator start 
new text entries with (pseudo?) Latin contents which is selected so as soon as you enter something 
the Latin is replaced. If you find this annoying, go to “Edit”->”Preferences”->”Type” and uncheck the 
box labeled “Fill New Type Objects With Placeholder Text”. 

When entering text, holding down Ctrl gets you Selection Tool. Clicking on the artboard with that 
Selection tool finishes the current text input but stays in text mode when you release Ctrl. Typing Esc 
finishes the input and goes to the Selection Tool. 
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This is the simplest way of entering text. You click somewhere on the artboard 
and then start typing. If you hit Carriage-return, the new line is directly below the previous one. 
There are many properties that you can modify such as typeface, size, weight, etc. There are also 
paragraph styles such as centered text, line spacing, etc. 

The Type Tool is also the tool you want to use for editing text on the artboard, even text that was 
entered using one of the more sophisticated tools. Using the Type Tool, you can select characters (or 
between two characters) in an existing string and then start typing. 

To use this tool, you first create an object. Typically one uses a rectangle, 
but the shape can be arbitrary. I once produced a Christmas letter that was in an area the shape of a 
Christmas tree. You select the object with this tool and the object disappears, but its outline remains 
and any characters that you type stay within that outline. If a word won’t fit on a line, it is placed on 
the next line. If there is more text than will fit in the area, it is still there but not visible, but if you 
resize the area larger, the text will reappear if the new area is large enough to contain it. 

You can create an arbitrarily shaped path (typically using the Pen 
Tool) and then have text appear along the path always perpendicular to the portion of the path 
where the character lies. 

When you use this tool, characters are placed in a vertical line, each 
one below the previous.  

Properties 
 
One of the most useful windows is the Properties window. The properties shown depend on 
whatever is the current selection. One property shown if an object is selected gives the x 

and y coordinates of the object and its width and height. The little matrix shown to the left lets you 
decided which x and y coordinates you want to see: one of the corners, the center, or the center of 
one of the sides. You can edit those numbers to place the object at an exact location. If nothing is 
selected, you are shown the properties of the artboard, allowing you to do things like show and hide 
the grid, lock and unlock guides, etc. 

Selecting 
At the top of the tool window are the “Selection Tool” (black inside) and the “Direct 
Selection Tool” (white inside). You will use these tools a lot. It’s probably worth learning 

the shortcut to choose them. Unless you are entering text, if you hit v on the keyboard, you will 
choose the selection tool, hitting a will choose the direct selection tool. If you are typing in text, or 
using pretty much any other tool, holding down the Ctrl key will make the Selection Tool active. 



9 
 

We will first discuss the “Selection Tool”. To select an object, you can click with the selection tool at 
any point on the object to select it. You can also drag a rectangle with the tool and select everything 
that is partially in that rectangle. You can add or subtract an object from the total selection by holding 
down Shift and selecting that object. 

Moving and Copying 
If you select an object (or group of objects), you can use the selection tool to move them. Simply 
mouse down with the cursor over a portion the object (but not a control point) and drag the object to 
the desired destination before you release the mouse button. If you hold down the Alt key during this 
process, the object is copied, leaving the existing object where it was and placing the copy where you 
let up the mouse button. If you hold down Shift, the direction of movement is limited to horizontal, 
vertical, or 45° away from one of those directions.  

If you wish to move an object a specific distance in x and y, this is accomplished by first selecting the 
object and then double-clicking the selection tool in the Tool Window.  This brings up a dialog box 
that allows you to specify the move as exact x and y amounts or as an angle and a distance. It also 
allows you to copy the object rather than just move it. If you’re a mathematician and are used to 
positive “y” values increasing as you go “up”, you’ll just have to get used to the fact that in Illustrator 
coordinates, y values increase as you go toward the bottom of the page. At least “x” values increase 
as you move to the right. 

If you have made a copy of an object by dragging or specifying a distance in x and y for the copy, 
there is a very useful  shortcut for making more copies. If you type Ctrl+d, which I think of as “do it 
again”, another copy will be made, the same distance away from the one previously made. 

Another way to move a selection is via the arrow keys on your keyboard. The default distance to 
move the selection is 1 pt (1/72 inch). The movement value can be changed by going to the “Edit”-
>”Preferences”->”General” window and changing the value of “Keyboard Increment”. 

Cutting and Pasting 
Once you have made a selection, you may delete it from the drawing with the Delete key. You can cut 
to the clipboard with Ctrl+x, or simply copy to the clipboard with Ctrl+c. Once the artwork is on the 
clipboard, it can be pasted back onto the artboard in three ways. The typical shortcut for pasting, 
Ctrl+v, will paste the artwork somewhere near the middle of the showing page. This is fine if you’re 
going to then move it where you want it. The other two options are quite powerful. Ctrl+f will paste it 
to the “front” of the illustration; Ctrl+b will paste it to the back, but most importantly, at the exact 
same x and y coordinates as the original object.  Layer position is particularly important for opaque 
objects. It is also importing for clipping where the clipping mask needs to be on top of what it is 
clipping. Selecting an object and then typing Ctrl+x, Ctrl+f is often used to make sure that the object 
is in front of other objects. 
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Modifying Objects 
Once you have drawn an object, you will likely want to make changes to it. Let us consider a few 
examples. 

Here is an example of a rectangle that has been selected with the 
(black) selection tool. There are “control points” in each of the 
corners and the center of each side. If you mouse down on one of 
the control point and drag, the rectangle will be resized. If you hold 
down Shift, it will keep the same ratio of side lengths. In each corner 

is a circular widget that allows you to convert this rectangle to one with rounded corners.  If you 
mouse down and drag one of the circles, you will change the corner radius for all four corners. 

This is an alternative way to scale an object or group of objects. With this tool, 
you already have a selection. You first click the mouse to establish the point about which the objects 
will be scaled. Then you mouse down and drag to scale the selection. Alternatively, you can make a 
selection and then double-click the Scale Tool in the Tool Window. The scaling will be relative to the 
center of the selection and you can specify exact amounts of horizontal and vertical scaling. 

 If you move the mouse just outside of a control point of a selected object, the cursor will change 
into a line with arrows, similar to the figure shown here. If you mouse down and drag, you can rotate 
the object. If you hold down Shift, you are constrained as to the angle of rotation. 

This is another way to rotate a selection. You can simply drag the selection 
around its center or you can first click somewhere on the artboard and rotate around that point when 
you drag.  

If you hold the Alt key down while you are dragging the rotation, you make a copy. If you hold the 
Shift key down, you are constrained to multiples of 45°. 

If you click with the Alt key down, that sets the rotation point and brings up a dialog box to allow 
specification of an exact rotation amount.  

If you double-click on the Rotate Tool in the Tool Window, you can specify the rotation of the current 
selection about its center. 
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Direct Selection 
Sometimes you want to modify only a portion of an object. This is where the “direct selection tool” 
comes into use.  

Here the direct selection tool was used to select just the lower right 
anchor point. We have the little circle for changing the corner radius, 
but in this case, it will change the radius for just that corner. Likewise, 
if we drag that anchor point elsewhere on the artboard we will distort 
the shape from a rectangle to some other quadrilateral figure. 

With lines created using the Pen Tool, the direct selection tool can be used to select a single anchor 
point and you can then play with the control lines to adjust the shape. If you have two lines that are 
not closed paths, you can select an end anchor point of both lines and join them together into a 
single line. This is done by typing Ctrl+j. If the two anchor points are not on top of one another, a line 
is drawn between them. 

There is a non-obvious but quite handy use for the direct selection tool. Suppose you have a relatively 
small object, say a rectangle, and you want to move or copy it without changing its size. When you 
select it with the selection tool, there are control points in every corner and the middle of every side. 
Finding some place to drag the object from can be a pain unless you are highly zoomed in. After you 
select the object with the selection tool, you can then choose the direct selection tool and use that to 
drag the object. You can even drag from an anchor point without modifying the shape of the object. 

Pathfinder  
 The Pathfinder Tool appears in the Properties window when two or 
more objects are selected, You can also open it by using the 

“Window” menu at the top of the page. The Shape Modes collection of icons, shown here, allow you 
to take two shapes and create a resulting shape that is the union of the two shapes, the lower one 
minus the top shape, the intersection of the two shapes or the two shapes minus their intersection. 
There are a number of other options but these are the most useful. 

Aligning Objects 
These icons allow you to take a collection of 
objects and rearrange them such that they are 

either aligned vertically or horizontally. You can choose to have the left sides, the centers, or the right 
sides aligned.  These icons are typically in the Properties window, but you can always open them from 
the “Window” menu at the top of the Illustrator window. 

Distributing Objects 
 If you have a collection of objects, probably 
aligned, but the spacing between them differs, 
you can redistribute those object so that the 

spacing is uniform. Simply select the collection and then click on the relevant icon.  
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Color 
Objects in Illustrator can have both a stroke color and a fill color (or in the case of a 
masking object, no color at all. There are color patches on the Tool Window that 
show the fill and stroke values for the current selection. To change a color, select the 
fill or stroke box (it will come to the front) and then use one of the many color 
related sub-windows, typically on the right of the workspace, or available from the 

“Window” menu.  

Another useful way to pick a color is to use the “eyedropper” tool. You use this tool to copy an 
existing color. Simply use the mouse to position the eyedropper over something on the artboard of 
the desired color and click. This can be quite useful if you have placed a photograph on the artboard 
and want to match one of the colors in the picture. 

The stroke and fill colors can be more sophisticated using things like gradients, but we are not going 
to deal with that today. 

If you are primarily using Illustrator to cut things on the laser cutter, your use of color will be 
somewhat limited, although there are options on laser cutter to cut different colors with different 
speed and power parameters. If you are using this feature, it’s probably a good idea stick to simple 
primary colors like “red”, “green”, etc. in order to make your life simpler when telling the laser 
printer which colors you used. 

Example 
I’m going to walk you through a project for the laser cutter in order to show you the use of a number 
of the tools described above. If you are reading this at home and have Illustrator, you could follow 
along and produce a similar drawing. Alternatively, http://helpx.adobe.com/illustrator/tutorials.html, 
mentioned above, has many videos you can watch and files supplied so that you can reproduce the 
video’s behavior.  

The project is to cut a small decorative box to hold a votive candle. We are going to cut it out of 3mm 
Baltic Birch plywood. 

Step 1, Create Document 
First, we create a new document with the “File”->”New” menu item (or type Ctrl+n). This brings up a 
dialog box with a number of parameters. We’ll chose a width of “24 in” and a height of “18  in”, that 
being the size of the bed of the laser cutter. I’m also changing the units from “Points” to 
“Millimeters” because I feel more comfortable working in metric measurements.  

Step 2, Create Layers 
Having done this exercise already, I’m planning on two layers. I’ll call the layers “guides” and “box”. 
Typically, I’m working on a document and say “gee, I think I want another layer” so I create it then.  

http://helpx.adobe.com/illustrator/tutorials.html
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Step 3, Choose Dimensions 
I found a glass votive candle holder in a closet in my garage. I took a few measurements and decided 
that the interior of my box should be 75mm x 75mm x 80mm. This will hold the glass unit without it 
sticking out the top. I’m going to decorate the sides with holes that the light will shine through. I need 
a little space below the decorations, and I want to have “feet” in the corners, so I’ll have another 
20mm of side with most of the side 10mm off the ground. 

Step 3, Create Guides for sides 
I’ve decided to put all of my guides in the layer named “guides” so I choose that layer in the “Layers” 
sub-window.  I start out with a horizontal line that will be the guide for the top of the side. I need 
another one 80mm down for placement of the board that holds the votive candle glass, and since I’m 
going to do a symmetric set of cutouts on the side, another line halfway between them is useful. 
Below the lower (80mm down) line, I draw two more lines 10mm apart. 

Now for the vertical guides. The first one locates the left edge of the side. I want the inside of the box 
to be 75mm, so the outside will be 75+3+3 or 81mm. Copy the left line 81mm to the right.  I’ll want 
the midpoint for my decoration so I’ll also copy the left line 40.5mm to the right. I’ll add a couple 
more vertical lines 10mm toward the center from each side to make it easier to draw my “feet”. 

Next we turn this collection lines into guides by selecting then and typing Ctrl+5. We could also use 
the “View”->”Guides”->”Make Guides” menu. At this point, I will lock the “guides” layer and click on 
the “box” layer to make that the active drawing layer. In the left picture below, I placed the upper 
corner of the set of guides at location 100mm, 100mm and turned on the ruler so that you can see 
the spacing of the guide lines.  We will make additional guides later, before we draw the bottom 
piece that the votive candle rests on. 

Drawing the sides 
Using the guide shown below, I can draw the outline of the side using the Pen Tool and clicking on the 
various intersections of guides 
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I’m going to make the side somewhat flower-like so I draw a circle in the middle and then use the 
Curvature Tool to draw a “petal”. I draw a curve, then reflect it about the vertical axis. Join the top 
and bottom control points with Ctrl+j. Then use the rotate tool (with Shift down) to make a copy 45° 
away, then Ctrl+d six times for a total of 8 copies of the petal, symmetric around the circle in the 
center.  

                                             

To dress up the side a little more, I create a new guide through the center but 22.5° away from 
vertical (to place it between two petals). I use that guide and the Rotate Tool to put some extra 
circles around the petals. I also need a way to attach the sides together and to attach the bottom 
(which is 20mm up from the bottom of the feet).  

For the sides, which are 100mm tall and 3mm thick, I’m going to cut tabs 25mm tall by 3mm wide on 
both sides that will mesh with one another. For the bottom I’m going to cut 5mm by 3mm holes that 
will accept tabs of that shape in the bottom. 

From a standpoint of laser cutting, this will cut out the sides as the skinny rectangles will fall off, but 
to make things look prettier and eliminate a few cuts, I used the Pathfinder Tool (Minus Front 
function) to simply cut the rectangles out of the shape of the side. 
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Now for the bottom.  I create a new set of guides that allow me to draw a 75mm square and then 
copy the 3x5 rectangles from the side and place them around all sides, carefully aligning the 
rectangles so that the tabs will line up with the holes that are cut in the sides. In this case, I really 
need to use the Pathfinder Tool so that the tabs won’t just fall off. I use the Unite function to 
combine the tab shapes with the bottom shape. 

                                   

Step 6, Preparing for the Laser Cutter 
We need four copies of the side and one bottom. This is simply done with the Selection Tool, and 
Alt+drag. The print driver for the Laser Cutter uses the stroke width to decide whether to cut a line so 
we select everything and use the selector at the top of the window to set stroke width to 0.07pt.  

Now we can head to the Laser Cutter. 
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